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Introduction 
MnPAVE is a computer program that combines known empirical relationships with a 
representation of the physics and mechanics behind flexible pavement behavior. The 
mechanistic portions of the program rely on finding the tensile strain at the bottom of the 
asphalt layer, the compressive strain at the top of the subgrade, and the maximum 
principal stress in the middle of the aggregate base layer. 
MnPAVE consists of three input modules: Climate, Structure, and Traffic; and three 
design levels: Basic, Intermediate, and Advanced. The level is selected based on the 
amount and quality of information known about the material properties and traffic data. 
In the basic mode, only a general knowledge of the materials and traffic data are 
required. The intermediate level corresponds to the amount of data currently required 
for Mn/DOT projects. The advanced level requires the determination of modulus values 
for all materials over the expected operating range of moisture and temperature. 
MnPAVE simulates traffic loads on a pavement using a Layered Elastic Analysis (LEA) 
called WESLEA.  It is a five-layer isotropic system program written in 1987 by Frans 
Van Cauwelaert at the Catholic Superior Industrial Institute Department of Civil 
Engineering in Belgium and modified in 1989 by Don R. Alexander at the U.S. Army 
Engineer Waterways Experiment Station in Vicksburg, Mississippi.  All layers are 
assumed to be isotropic in all directions and infinite in the horizontal direction.  The fifth 
layer is assumed to be semi-infinite in the vertical direction.  Material inputs include 
layer thickness, modulus, Poisson’s ratio, and an index indicating the degree of slip 
between layers.  MnPAVE assumes zero slip at all layer interfaces.  Other inputs 
include load and evaluation locations.  Loads are characterized by pressure and radius.  
The LEA program calculates normal and shear stress, normal strain, and displacement 
at specified locations. 
MnPAVE output includes the expected life of the pavement, the damage factor based 
on Miner's Hypothesis. Reliability has been incorporated into the latest version. There is 
also a batch section for testing a range of layer thicknesses. In Research Mode 
(accessible from the "View" menu in the main MnPAVE window), output includes 
various pavement responses for each season. 
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Units 
The default system of engineering units is English, however the system of units can be 
changed in any of the main modules.  System International (SI) or English units may be 
selected. 
 
English  SI  
Length 
1 in  = 25.4 mm 
1 ft  = 0.3048 m 
1 mi  =  1.609344 km 
 
Weight 
1 lb  = 4.448222 N 
1 kip  = 1000 lbs 
1 kip  = 4.448222 kN 
 
Pressure (Modulus) 
1 psi  = 6.894757 kPa 
(pounds per square inch) 
1 ksi = 1000 psi = 6.894757 MPa 



Installing MnPAVE 
The installation file,  can be downloaded from the MnPAVE web 
site: http://www.dot.state.mn.us/app/mnpave .  Double click on and follow the 
instructions in the following installation windows: 
 
1. The first Install window contains version and contact information. 

 
 
2.  Clicking "Setup" in the Winzip Self-Extractor window initiates the installation process. 

 

  

http://www.dot.state.mn.us/app/mnpave


3. The Welcome window contains brief setup instructions.  

 
 
4.  Update information is included in this window.  This information can also be viewed 
at http://www.dot.state.mn.us/app/mnpave/history.html . 
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http://www.dot.state.mn.us/app/mnpave/history.html


5.  The executable MnPAVE.exe and Help files will be placed in Program 
Files\MnDOT\MnPAVE unless a different location is specified. 

 
 

6.  A MnPAVE folder will be added to the Windows  Menu, unless a different 
folder is specified. 
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7.  Finish 

 

At this point there will be a MnPAVE icon  on the desktop and in the Windows  
menu under the folder name specified in Step 6. 
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Starting MnPAVE 
The program can be started by double-clicking on the MnPAVE icon  on the desktop 
or selecting MnPAVE from the Windows  menu under the folder name specified 
in Step 6 of Installing MnPAVE. 
At this point, the Main Control Panel is visibile: 

 

A new MnPAVE file can be opened by clicking on the  icon or by selecting "New" 
from the "File" menu.. 

An existing MnPAVE file can be opened by clicking on the  icon or by selecting 
"Open" from the file menu.  A recently saved file can also be selected from the list at the 
bottom of the "File" menu. 

Changes to the current file can by saved by clicking on the  or by selecting "Save" 
from the "File" menu.  Changes can be saved as a new file name by selecting "Save As" 
from the "File" menu. 
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Project Information 
Project information is a form for entering information necessary to identify a MnPAVE 
project.  Mn/DOT District, county, city, highway, construction type, design engineer and 
project notes are entered in this module. 
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Climate 
Climate contains a map of Minnesota where more specific location data can be entered.  
MnPAVE calculates season lengths and temperatures for each location using data from 
surrounding weather stations. 
MnPAVE has five default seasons based on material properties measured at the 
Mn/ROAD research site throughout the year.  Spring is divided into two seasons 
because of the drastic changes in aggregate base and subgrade soil properties during 
the Spring thaw period. 
MnPAVE calculates the average pavement temperature for each season based on data 
from surrounding weather stations.  Details of this calculation can be viewed in the 
Details window. 
The county and district can be selected from menus in the Project Information window.  
Clicking on the map will also select them.  The season lengths and average seasonal 
temperatures are shown in the left portion of the Climate window. 
As the pointer moves over the map, the current district, county, and coordinates under 
the pointer are displayed to the left under Pointer Location.  Click the left mouse button 
to select this location.  The district and county can also be selected in Project 
Information. 
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Climate Details 
Seasonal air and pavement temperatures can be viewed in this window.   
The air temperature at the selected location is based on a weighted average of data 
from weather stations in a 75 mile (120 km) radius.  Each seasonal air temperature 
value represents the average daily temperature for that season.  The equation used to 
convert air temperature to pavement temperature can be seen by clicking the 

 button.  
Early Spring Thaw Depth is the assumed depth of the thawed/frozen interface during 
Early Spring.  The thawed portion of the base and/or soil is assumed to have a high 
moisture content and low modulus.  Seasonal modulus multipliers for the selected 
pavement materials can be viewed in Advanced Structure.  If the thaw depth extends 
into a soil layer, then the Late Spring multiplier is used for the thawed portion of the soil. 
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Structure 
When Structure is opened for the first time in a project, the HMA Mix Properties 
Window opens to make sure all mix design information is entered correctly.  Mix design 
information such as asphalt binder content and gradation are required to estimate the 
HMA dynamic modulus.  Currently, the selection of a binder grade serves only to 
document the binders used in the design.  Only PG 58-28 data was available for the 
current MnPAVE calibration, so all HMA layers will have PG 58-28 properties regardless 
of the binder type selected. 
Up to three HMA types can be defined for layer 1.  Since the LEA procedure only allows 
five layers, multiple HMA layers are combined into a single layer using the equivalent 
thickness method. 
Click on the colored bar to select a default gradation based on a Mn/DOT specification.  
A custom gradation can be defined by entering numbers in the “Percent Passing” edit 
boxes. 
The Advanced button next to each lift can be clicked to view more details about how 
HMA modulus is calculated. 
The Structural Number (SN) is calculated using the method described in Section 2.3.5 
of the 1993 AASHTO Guide for Design of Pavement Structures. 
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Basic Structure 
Basic Structure is intended for low-volume roads or designs that don’t require a high 
degree of reliability.  MnPAVE uses default design modulus values.  These modulus 
values are adjusted for seasonal variations in moisture and temperature. 
Click on a layer button to select the number of layers in the pavement structure.  The 
bottom layer is always semi-infinite.  A MnPAVE pavement structure must have 
between two and five layers.  Due to limitations in the LEA procedure, layer 5 cannot be 
analyzed for rutting.  Therefore layers 2 through 4 must contain at least one engineered 
soil1 or undisturbed soil2 layer. 
The Default Structures area provides shortcuts for several common pavement 
structures.  Select the desired pavement structure, then adjust the layer thicknesses 
and material subtypes. 
Material Types for each layer are selected on the left side of the Structure window under 
Edit Structure.  Layers with a white pointer arrow   can be clicked to select a different 
subtype. 

 

                                            
1 Soil that has been blended and compacted prior to construction. 
2 Existing soil that has not been reworked.  Because of uncertainty in the quality and uniformity of the 
material, the default undisturbed soil modulus is equal to half of the corresponding engineered soil 
modulus. 
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Confidence Level   
This value is used to adjust layer thickness and modulus values to assure that a 
proportion of the pavement area meets or exceeds the desired values, based on the 
coefficient of variation (COV).  The higher the confidence level and COV the more the 
value is reduced.  A confidence level of 50% results in no reduction (the mean value is 
used in the simulation).   The Confidence Level differs from the reliability value 
calculated in the Output Monte Carlo simulation.  The Confidence Level reduces the 
values for all layers and acts as a factor of safety to account for variability and 
uncertainty.  A Monte Carlo simulation should be run on the final design to determine 
reliability.  If the user intends to use Monte Carlo simulation to determine the final layer 
thicknesses, selecting a Confidence Level of 10 to 15% less than the desired reliability 
may be helpful.  In Version 5.306 the Confidence Level was set at a default value of 
70% for the Standard Design Mode.  It is adjustable in Research Mode. 
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Thickness Views 
Thickness Values Displays the design thickness.  If the Confidence Level is 50%, the 
design thickness will be used in the simulation.  Higher confidence levels result in an 
adjusted thickness for the simulation. 
Thickness Coefficient of Variation indicates the variability of the thickness value of 
each layer. 

 
Adjusted Thickness Displays the reduced thickness used in the pavement simulation. 
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Intermediate Structure 
Intermediate Structure has a form for entering test data for aggregate base and 
subgrade soils.  These values are converted to design modulus and adjusted for 
seasonal variations  If no test has been performed on a given material, it's box can be 
left unchecked to use default Basic material properties.  Basic HMA data is used in this 
mode.  A material subtype need not be selected if test data is entered.  If the material 
subtype is known, it can be selected by clicking on the pointer arrow  to the right of the 
edit box.  If the material subtype is not known, select Unknown from the list.  To view 
the calculated moduli, click on the Advanced tab. 
The View selection allows the user to view test values, resistance factors, or COV.  
Resistance factors are multiplied by the modulus values of aggregate base and 
subgrade soil to adjust for seasonal moisture conditions. 
If Other is selected in the Edit Structure area, material properties are edited in 
Intermediate or Advanced Structure.  Design Modulus, Poisson's Ratio, and COV. 
must be entered. 
The Moisture Data button shows a prototype unsaturated soil model that will be used in 
a future version of MnPAVE to provide more accurate seasonal material properties. 
The Mohr-Coulomb button illustrates the method used to analyze shear stress in the 
base layer. 
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Advanced Structure 
Advanced Structure requires the input of design modulus values for every layer and 
every layer.  
Design Mode:  Click on Basic, Intermediate, or Advanced to view the corresponding 
material properties below.  Selecting Basic or Intermediate displays values calculated 
based on data from those modules.  In Advanced mode, all material properties must be 
entered manually. 

 
The design mode is displayed above the “Finished” button to confirm that the correct 
mode is selected.  Any editing that is done in the Basic, Intermediate, or Advanced 
windows will change the mode.  If any editing causes the wrong mode to be selected, 
this can be corrected prior to clicking on the “Finished” button. 
Import Moduli 
These buttons appear in the Advanced Structure window when Advanced Mode is 
selected.  Basic default modulus values can be imported into Advanced Mode when 
custom values are not available for all layers and seasons.  
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Structure Views 
Structure views for all design levels can be viewed by clicking the Advanced tab. 
Design Modulus displays design modulus values.  For pavement simulations these 
values are adjusted according to the Confidence Level. 
Adjusted Modulus indicates how  values used in the pavement simulation are adjusted 
according to the Confidence Level. 
Poisson's Ratio is a measure of a material's tendency to expand in the horizontal 
direction when it is compressed in the vertical direction.  Poisson's Ratio is used in 
Layered Elastic Analysis (LEA) simulations. 
Seasonal Modulus Multipliers displays seasonal multipliers for each aggregate base, 
subbase, and soil material (HMA moduli are calculated for each season).  Multipliers 
indicate moisture susceptibility and the state of the material (frozen or thawed). 
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Modulus Coefficient of Variation (COV) 
The default modulus data used in MnPAVE fits a lognormal distribution (log-transformed 
data fits a normal distribution).  The COV of this data is calculated as follows: 

1001
2

×−= σeCOV  

Where 
COV = Coefficient of Variation (%) 

2σ  = variance of log-transformed data 
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Overlay Design 
While a complete Mechanistic-Empirical overlay design method has not yet been 
developed for MnPAVE, overlays can be designed using the conventional fatigue and 
rutting criteria to check for structural capacity.  In addition, FWD3 deflections and the 
TONN method can be used to determine the necessary overlay thickness to avoid the 
need for Spring load restrictions. 

Basic Overlay Design Procedure 
While MnPAVE can check for fatigue, rutting, and shear failure in the aggregate base, 
these are often not the primary factors in determining overlay thickness.  When 
designing overlays in Basic mode, the designer must also rely on other overlay design 
methods and guidelines.  Do Project Information and Climate, and then go to Structure. 

 
Select the default overlay structure.  If the old HMA properties for this layer have not yet 
been defined, the HMA Mix Properties window will open up. 

                                            
3 Falling-Weight Deflectometer:  A device that measures deflections that result from a 
weight dropped onto the pavement.  These deflections can be used to determine the 
modulus of the pavement layers. 
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If the HMA Mix Properties window did not open, click on the gray Old HMA subtype bar. 
Select the binder grade of the old HMA and any other mix properties that are known and 
click OK. 
Check the Mill and Overlay checkbox if applicable (the old HMA thickness should be the 
thickness after milling). 
Define the HMA properties for the new (overlay) HMA. 
Define the other pavement layers to the extent that their material types and thicknesses 
are known. 
Continue to Traffic and Output. 
If this is a Mill and Overlay project, HMA fatigue and subgrade rutting results will be 
displayed.  If it is not a Mill and Overlay project and rutting has been observed in the old 
HMA, check the Rutting is present in old HMA box.  If rutting is not present in the 
existing HMA, it is not necessary to check for subgrade rutting. 
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Intermediate Overlay Design Procedure 
Select material types and subtypes for the layers, with HMA overlay in layer 1 and Old 
HMA in layer 2. 
Click on the Intermediate tab and select FWD Deflections. 

 
The FWD Data window will open.  FWD loads and deflections must be entered in the 
spreadsheet.  Data entry is greatly simplified by opening the FWD deflection file in a 
spreadsheet such as Excel, cutting and pasting to put the data in the appropriate 
columns, and then pasting the data into MnPAVE. 
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Pavement temperature can be entered by two methods.  If the pavement temperature is 
known, uncheck the  checkbox and enter the known pavement 
temperature values in column 2.  If the pavement temperature is not known, it can be 
estimated using the BELLS 3 method.  Enter the previous day's high and low air 
temperatures in the appropriate boxes and the infrared surface temperatures in column 

2.   

If Mill and Overlay was checked, the  button must be clicked to define the old 
HMA thickness at the time of the FWD testing and after milling. 
Annual Average Daily Traffic (AADT) must also be entered.  If this value is not known, it 
can be estimated from the design ESALs and the road type by clicking on the  
button.  

Select the soil plasticity at the bottom by clicking on the  button.  Clicking 
on the button toggles through three levels:  Plastic, Semi-Plastic, and Non-Plastic.  If 
this property is unknown, assume the soil is plastic. 

The  value is used in the TONN procedure.  This value is typically 0.11 
and ordinarily does not need to be changed. 

 24



Once all data has been entered, click on the  button. 

 
If BELLS3 was used, column 2 displays the estimated pavement temperatures at 1/3 of 
the pavement depth.  Column 3 displays the fwd load, and column 4 displays the center 
deflection normalized to a 9 kip (40 kN) load (all deflections are normalized for the 
calculations).  Column 5 displays the calculated HMA modulus and column 6 displays 
the Spring Load Restriction recommended by the TONN procedure for the selected 
overlay thickness.  Column 7 displays the overlay thickness recommended by the 
TONN procedure.  The mean and standard deviation for these values is displayed at the 
bottom of the table. 
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Traffic 
Traffic loads are simulated in MnPAVE to estimate the life of a given pavement design.  
The default traffic load type in MnPAVE is the ESAL (Equivalent Single Axle Load). 
ESAL is a means of simplifying traffic data for pavement design.  An ESAL is defined as 
an 18 kipkip (80 kN) dual tire axle with a tire pressure of 80 psi (552 kPa).  Other axle 
loads and configurations can be converted to ESALs by using Load Equivalency 
Factors (LEF) as defined in Appendix D of the 1993 AASHTOAASHTO Guide for 
Design of Pavement Structures.  An LEF is the number of  18 kip ESALs required to 
cause the same amount of damage as the axle in question.   
Load Spectrum is a more comprehensive way to characterize the expected traffic for a 
pavement design.  Load applications are categorized by axle type and load range. 
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ESAL 
Lifetime ESALs are the number of ESALs expected during the number of years 
specified in Design Period Length. 
The First Year value is calculated based on the Design Period Length and Growth Rate. 
If only First Year ESALs are known, it can be entered here and Lifetime ESALs will be 
calculated based on the Design Period Length and Growth Rate. 
The Design Period Length is typically 20 years.  This value can be adjusted by the user. 
The Annual Growth Rate determines the amount that traffic increases during each year 
of the Design Period.  Traffic analysis conducted by Mn/DOT has indicated that a simple 
growth model is appropriate for most Minnesota routes (traffic increases by a fixed 
amount each year). 
Allowable Stress is used to protect against failure in the aggregate base layer due to a 
single heavy load event.  For this reason, the axle weights entered in this window 
represent the heaviest axles expected.  The default values are consistent with data from 
around the state and do not correspond to legal load limits.  Unless the designer has 
specific data to indicate lower axle weights are appropriate, the default values should be 
used. 
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Basic Spectrum 
Basic Spectrum determines a load spectrum using design lane AADT, pavement life, 
growth rate, and route type. 
When a traffic type is selected in Basic Spectrum, weigh-in-motion (WIM) data from 
routes of that type is used with the other traffic inputs to calculate the load spectrum 
used in the pavement simulation.  Weigh-In-Motion (WIM): a device that measures 
wheel or axle loads on a pavement while the vehicle is in motion. 

 
First Year Design Lane AADT is determined by multiplying the average annual daily 
traffic forecast for the first year by a directional distribution factor (DD) and a lane 
distribution factor (DL): 
 
First Year Design Lane AADT = First Year AADT x DD x DL 
 
DD = 0.5 if traffic is approximately equal in both directions. 
DL = 1.0 for 2-lane highways. 
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The 1993 AASHTO Guide for Design of Pavement Structures provides the following 
guidelines for DL on multi-lane highways: 
 

Number of Lanes in Each Direction Percent of Traffic in Design Lane 

1 100 

2 80 - 100 

3 60 - 80 

4 50 - 75 
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Intermediate Spectrum 
Intermediate Spectrum determines a load spectrum using design lane AADT, pavement 
life, growth rate, and vehicle type percentages. 
 

 
 
Vehicle types are quantified in pavement design procedures to more accurately define 
the loads on the pavement.  Vehicle type data can be obtained from manual counts or 
from automatic vehicle classification systems.  The Mn/DOT classification system differs 
somewhat from the FHWA system.  Data in FHWA format can be entered and MnPAVE 
will convert it into Mn/DOT format.  Vehicle-specific axle weight distributions are used to 
convert vehicle type data into a load spectrum for pavement simulations. 
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Mn/DOT Classification System 

 
 
FHWA Classification System 
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Advanced Spectrum 
In Advanced Spectrum, the user can paste formatted load spectrum data or use Weigh-
In-Motion (WIM) data.  
The tire pressure, tire spacing, and axle spacing all affect the stresses and strains 
throughout the pavement structure.  The default values shown are fairly typical of 
vehicles in the United States. 
The data entry area is similar to a spreadsheet.  Lifetime load spectrum data or WIM 
data can be formatted in a spreadsheet program such as Excel, then copied and pasted 
in the MnPAVE Load Spectrum window. 
Weigh-In-Motion(WIM) data that is collected for a period of time can be pasted in the 
MnPAVE Load Spectrum window and MnPAVE will calculate the load spectrum for the 
pavement simulation. 
The axle weights are divided into 2-kip (2000 lb or 9 kN) ranges as in the 1993 
AASHTO Guide for Design of Pavement Structures. 
Axle types can be checked or unchecked depending on what type of trucks traffic is 
expected on the pavement. 

 
If Seasonal Traffic is checked, data must be entered (or pasted) for each season.  
Select seasons by clicking on the "All Seasons" button (it will then advance to the next 
season with each click).  

 32



ESALs are calculated according to the 1993 AASHTO Guide for Design of Pavement 
Structures using Load Equivalency Factors (LEF). 
LEFs are multiplied by the repetitions of the corresponding axle type and weight to 
obtain an equivalent number of 18,000-lb (80 kN) ESALs.  These values are then 
summed to provide a single ESAL value that can be used in a variety of pavement 
design methods. 
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Output 
Output displays the expected life based on fatigue and rutting damage.  Optimum layer 
thickness can be determined automatically in ESAL mode. 

Fatigue and Rutting Models 
The expected life of a pavement is calculated by simulating the strains due to traffic 
loads and using an empirical transfer function to determine the Allowed Repetitions4 for 
each load.  If the applied load repetitions exceeds the allowed repetitions, the pavement 
is assumed to have failed. 

 

                                            
4 The number of repetitions of a given axle load that are assumed to cause pavement failure by fatigue 
cracking or rutting 
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Basic Output 
Basic Output displays the expected years of pavement life based on calculated fatigue 
and rutting damage.  The pavement damage is also expressed as a percent contribution 
by each season. 
Click “Life” to view the expected years of pavement life based on an analysis of fatigue 
and rutting damage.  Click “Damage” to view the corresponding damage factors (a 
value of 1 or greater indicates failure prior to end of the designated design period).  
If fatigue or rutting values are too low or too high, Material subtypes and layer 
thicknesses can be adjusted.  After each change “Recalculate” must be clicked to view 
the new results.  For Basic designs, HMA and aggregate subtypes can be adjusted in 
Output.  For Intermediate designs, only HMA can be adjusted in Output (other materials 
must be changed in Structure).  In Advanced mode, all material types must be changed 
in Structure. 

 
Thickness Goal Seek is a tool for determining design layer thicknesses in ESAL mode.  
To adjust the HMA layer only, select “Layer 1” and click on .  A 
number of cycles will be executed until the pavement fails in neither fatigue nor rutting. 
When Thickness Goal Seek is done for non-HMA layers, the HMA layer will be adjusted 
for fatigue first (if necessary), and then the selected layer will be adjusted.  This is 
because adjusting underlying layers has a relatively small effect on fatigue life and may 
result in a large number of cycles and very thick layers. 
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After running Thickness Goal Seek, layer thicknesses can be adjusted manually to 
obtain the desired structure.  
The relative damage effect from each season is displayed on the right side of the 
window.  These values are affected by both the magnitude of strain that occurs during 
each season as well as the season length. 
Results can be exported to a text file (comma or tab delimited) or to an “Excel” file.  The 
Excel file is actually a tab delimited text file with an “xls” file extension.  Double-clicking 
on this file opens it in Excel, but it must be “Saved As” Excel to convert it to true Excel 
format. 
The Design Summary contains expected life and damage, project information, and 
limited structural and traffic information. 
Damage Details includes more seasonal and traffic information. 

 
Printing 
A summary report can be printed by clicking on the printer icon with the white paper  
or by selecting "Print Design Summary" from the "File" menu.  The summary report can 
be previewed by clicking on the  icon or by selecting "Print Preview" from the "File" 
menu. 
A screen shot of the output window can be printed by clicking on the printer icon with 
the gray paper .  Most other windows have a printer icon that can be clicked to print a 
screen shot. 
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Batch Mode 
The batch mode allows the user to specify a range of layer thickness values and have 
all results tabulated in a text file or spreadsheet. 
Check the box for each layer for which the thickness will be varied.  Type the thinnest 
value in the "Begin" box, the thickest value in the "End" box, and the amount to increase 
the thickness in the "Incr." box.  Damage Limits are used to exclude extremely over- or 
under-designed structures from the output file.  When Set Frost-Free Depth is selected, 
each simulated structure will be adjusted so that the specified thickness of granular or 
better material is placed above the subgrade soil. 

The  button will prompt you for a filename in which to save the results.  
Excel (xls), tab-delimited text (txt) or comma-delimited text (csv) formats can be 
selected.  
The value under Batch Cycles is the number of structures that will be simulated.  If Set 
Damage Limits is checked, the number of lines in the output file may be fewer than this 
value. 
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Reliability 
Output reliability considers the variability of the thickness and modulus values for each 
layer to determine a reliability value for the pavement design.  
The reliability will not necessarily agree with the confidence level selected in Structure 
because the confidence level selects the "worst case" thickness and modulus value for 
each layer while the reliability analysis considers a random combination of thickness 
and modulus values. 

The number of Monte Carlo cycles can be adjusted by clicking the  button.  A 
sensitivity analysis was conducted to determine the optimum value of 2500 cycles.  

The  button runs the selected number of Monte Carlo cycles.  The 
time for this process ranges from less than one minute to a few minutes for an ESAL 
design (depending on the computer's processor speed) and up to several hours for a 
load spectrum design. 

Check the  box to save the results in an Excel or text file at 
the end of the simulation.  

 
Quick Reliability uses equations derived from running a range of full Monte Carlo 
simulations to estimate the Monte Carlo reliability for a given structure.  This is a time-
saving feature that allows quick adjustments in the structure.  Once the desired quick 
reliability value is reached a full Monte Carlo reliability should be run for verification. 
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Research Mode 
The standard design mode in MnPAVE provides the features necessary to complete a 
pavement design.  Research Mode can be selected from the Main Control Panel from 
the View menu.  

 
In Research Mode there are more features and more flexibility in entering data.  
However, there is one important difference in the way hot-mix asphalt (HMA) modulus is 
determined.  In Standard Mode, all asphalt binders have the same properties as PG 58-
28 for the following reasons: 
1. PG 58-28 binder is essentially equivalent to the type of asphalt binder in most of the 
pavements used to calibrate MnPAVE. 
2. The modulus-based simulation procedure does not account for the added benefits of 
polymers in some PG grades.  As a result, the fatigue and rutting performance of 
polymer-modified asphalts may be misrepresented.  A prototype polymer shift-factor 
based on torsional fatigue tests has been included in Research Mode. 
In order to have comparable results when switching between Standard and Research 
modes, the binder selected in Research mode should be PG 58-28. 
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Contact Information 
Bruce Tanquist 
Assistant Pavement Design Engineer 
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1400 Gervais Ave. 
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Phone:  651-366-5422 
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bruce.tanquist@state.mn.us 
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Research Services 
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